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Welcome to Evernote for Mac! This document will guide
you through the basics of using Evernote for Mac. For
more information, be sure to visit our official
Knowledge Base, a growing collection of support articles
and frequently-asked questions. If you require
assistance, we have a dedicated support team ready to
answer your questions.
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What are the keyboard shortcuts in Evernote for OS X?

Minimum OS X System Requirements

Evernote for OS X requires an Apple Mac running Mac OS 10.5.8 or later (including 10.6).

Creating Your Evernote Account and Signing in under
Mac OS X

After you've downloaded and installed Evernote for Mac, it's time to create your Evernote
account (if you haven't already). Once the Evernote installation application completes, you'll
be greeted with the Evernote welcome screen. Here, you can enter your account credentials
if you already have an account, or create a new account by clicking "Get a free Evernote
account now":

This will launch the Evernote account creation screen, which contains a series of fields that
you'll need to complete in order to continue including your name, email address, desired
username and password.

Once you've completed and submitted this form, your account will be created and Evernote
will launch. You'll already be logged in.

If someone else wants to access their Evernote account on the same computer, you can
change the current user account in Evernote for Mac by clicking on Account Info under the

http://evernote.com/about/download/


main Evernote menu. Here, you can clear the current username and password and fill in the
details for whichever account you'd like to use..

An Introduction to Notes

Notes are the basic building block of your Evernote account. Everything stored in Evernote is
stored in a note. Each note can contain one or more the following:

Plain or rich text
Images (dragged from either your desktop or web browser)
PDF files
Any file (Premium users only)

The built-in note editor also allows for simple styling like different fonts, text sizes,
bold/italic text, etc., as well as the creation of simple tables. Virtually all of this data can be
dragged, copied or typed into the note body.

All notes have a series of attributes (that is, pieces of information about the note itself) that
can be used for searching or filtering your notes, including:

The date the note was created and, if applicable, modified
The location where the note was created, expressed as a set of GPS coordinates (optional -
usually added when the note was created using a mobile app)
A URL if the note's content was clipped from the web (optional)
The notebook where the note lives

There are others, but these are the common ones that most folks would make use of. For
examples on using these to search your notes, check out the article on the various search
operators available for Evernote search.

The maximum allowed size of a note (including attached files) is 25 megabytes (mb) for free
account holders and 50mb for premium subscribers.

An Introduction to Notebooks

Evernote allows you to separate your notes into named containers called Notebooks. How
you organize your notes is up to you, but it's not uncommon to have a separate notebook for
a project you're working on or a specific area of your life (for example, Finances or Cooking).

Evernote notebooks can be one of two types: Local or Synchronized. Local notebooks will
only exist on the computer where they are created and are not synchronized to Evernote on
the web. Notes that live in synchronized notebooks will be synchronized to Evernote on the
web and to the rest of your Evernote-enabled computers and devices.

Both of the desktop clients and the Evernote web site allow the creation of new notebooks.
Currently, Evernote mobile applications do not support creating notebooks or modifying
notebook properties. Each Evernote account can have a maximum of 250 notebooks.

An Introduction to Stacks

Just like notebooks in Evernote are containers that hold notes, stacks are containers that
hold notebooks. Stacks allow you to group your notebooks however you like into named



containers that make sense for you.

To create a new stack, right click a notebook and hover over "Add to Stack". This will show
you a menu of all of your existing stacks, as well as the "New Stack" option. Selecting "New
Stack" will create a new stack and add the selected notebook to that stack.

Once you've created your stack, you can rename or delete it by right-clicking it and choosing
the appropriate option. You can change the sort order of the contained notebooks as well as
share all of the notes in the entire stack:

Stacks are a great way to add an additional level of organization to your Evernote notes. Each
stack you create will count as one of your 250 allowed notebooks.

An Introduction to Tags

Tags are pieces of text that are attached to notes to help describe the note's contents. For
example, if you have a note containing a recipe for buttermilk pancakes, you might add tags
like 'recipes', 'breakfast' or 'pancakes'. Or, say you have a note containing a scanned PDF of a
recent electric bill. This note might be tagged with 'bills', 'electric' or 'expenses'.

Adding one or more tags to a note using Evernote on the desktop is as simple as dragging the
tag from the tag list on the left and dropping it onto the desired note. This also works with
multiple tags and multiple notes; in other words, you can select multiple notes and drag
multiple tags onto those notes at once to assign all of the tags to each of the selected notes.
Alternately, you can click on the tags field in the note editor and type in whichever tags
you'd like to use.

Tags can be added or changed on any device that supports Evernote. The Windows and Mac
client applications support tag nesting, or tags that are listed inside other tags. Just click and
drag any tag onto another tag it will become a child of the second tag. This feature doesn't
have any bearing on the tag itself and is only available as a means to make your tags easier
to read and navigate.

If you'd like to rename a tag, find it in the tag list on the left, right click it and choose
"Rename Tag". Note that renaming a tag will replace every instance of that tag with the new



name.

Overview of Account Data Limits

Each Evernote account is subject to the following limitations:

100,000 Notes
250 Synchronized Notebooks (including Notebook Stacks). All 250 notebooks can be
shared. There is no limit to the number of Local Notebooks (which aren't synced) you can
have.
10,000 Tags
100 Saved Searches

How Evernote sync works

All of your notes (unless stored in a local -- that is, not synchronized -- notebook) are
synchronized to Evernote on the Web. Evernote's servers house a copy of all synced notes
because all of the Evernote client applications, both mobile and desktop, connect to Evernote
on the web to get the latest version of the notes for each user.

Evernote's service and software applications are arranged in what's called a "hub-and-
spoke" configuration. This means that every single sync operation that takes place will
involve Evernote on the web (the "hub"). For instance, if you initiate a sync from Evernote on
your desktop computer, any new or updated content will be uploaded to Evernote on the
Web so they'll be ready to be downloaded when any of your other devices initiate a
subsequent sync.

Occasionally, two copies of the same note will be found to be in conflict. This could arise
when a given note is edited in two different locations before a sync has taken place. In this
instance, the note will be placed into a temporary "Conflicting changes" notebook. You can
then view both the local version of the note and the conflicting version from the server and
manually apply any changes that couldn't be merged automatically. Once you're satisfied
that original version has all of the changes, delete the version in the "Conflicting changes"
notebook (as well as the notebook itself, if it's empty).

Adding Content to Evernote from the Mac OS X Desktop

Evernote for Mac provides several ways to easily clip content into your Evernote account.
Let's look at each one and discuss how to use it.

SCREEN  CAPTURE

Evernote for Mac allows you to capture portions of your desktop directly into a new note in
Evernote. You can select a custom rectangular region of the screen, a specific window or
even the entire screen.

To capture a specific window or region of the desktop, click the elephant icon in your
menubar, then select "Clip Rectangle or Window to Evernote". A small crosshair will appear.
If you want to grab a specific window, just click once anywhere inside that window. If you
want to grab a portion of the desktop, click and hold the mouse button, then drag the
crosshair over the region you'd like to capture. In either case, releasing the mouse button
will open your new Evernote note (which will be part of your default notebook) containing
the image you just grabbed.



To capture the entire desktop, simply click the elephant icon in the menubar and select "Clip
Full Screen to Evernote". This will immediately grab whatever is on your desktop and add
that image to a new note in Evernote in your default notebook.

PASTE FROM ANYWHERE

One of the global keyboard shortcuts offered by Evernote is the "Paste to Evernote" action.
This means that, no matter what application is currently active, you can strike the
appropriate keystroke—⌘+⌃+V by default—or select the "Paste to Evernote" option after
clicking on the elephant in the menubar and whatever you last copied to the system
clipboard (using ⌃+C) will be pasted into a new note in Evernote in your default notebook.
The keyboard shortcut used to paste into Evernote is configurable: visit the Shortcuts tab in
the Evernote Preferences.

DRAG AND  DROP

Adding images, PDFs and—if you're a premium user—other files to Evernote is as easy as
dragging them onto the Evernote icon in the Dock. This will attach the file to a new note in
your default notebook.

ADDING  CONTENT  USING  THE APPLICATION MENUS

To attach a file to a note using the menus in the Evernote client, select a note in the note list,
then click File > Attach Files. This will spawn the file chooser dialog box where you can
select the files you'd like to attach. Just select the file or files you'd like to attach (You can
use ⌃+click to select multiple files) and click Open.

ADDING  AUDIO  NOTES

All modern Apple computers ship with an internal microphone, so chances are your Mac can
record your voice without any additional hardware. To add audio to an existing note, click
the small microphone in the toolbar above the note body:

If you want to create a new audio note, click the Audio Note button in the toolbar in the
main Evernote window:

Either action will open the audio recorder; click Record to begin recording and Stop to stop
recording. The resulting audio file will be attached to your note.

How to Install and use the Web Clipper for Safari



The Safari Web Clipper installs automatically when Evernote for OS X is installed (unless you
installed Evernote from the Mac App Store, in which case you'll need to install it by clicking
the option in the Clipping section of the Evernote preferences).

There are three ways in which content can be clipped from a web page using the Safari
clipper:

1. Click the elephant button in your toolbar without highlighting any part of the web page
you're currently viewing. This will clip the entire page.

2. Click the elephant button after having highlighted a portion of the web page. This will clip
only the selected content.

3. Hold the Shift key while you click the elephant button. This will create a PDF of the
current web page. This can be useful if you're interested in maintaining the formatting of
the page, but hyperlinks and other clickable elements will no longer respond to mouse
clicks. If you want to be able to visit links within a clipped page, you'll need to use one of
the first two clipping options listed above.

All of the above actions will clip the relevant content into a new note whose title will be the
title of the web page being clipped. Also, the URL attribute of the note will be set to the URL
of the web page being clipped.

How to Install and Use the Web Clipper for Firefox

First, you'll need to install the Evernote Web Clipper add-on for Firefox. Once you've
installed the add-on and restarted Firefox, you'll have an Evernote button in the toolbar at
the top of your browser.

There are two types of clipping content using the Firefox Web Clipper: full web pages and
partial web pages. If you click the Evernote button in your toolbar without highlighting any
part of the current web page, the entire web page will be clipped. If you select a portion of
the content with your mouse before clicking, only the selected content will be clipped. Either
way, clicking the Evernote button will cause the content to be clipped to your local Evernote
application, not Evernote on the Web.

(Note that clipping with the Firefox extensions requires that Firefox be configured to support
third-party cookies. This feature is enabled by default in new Firefox installations, but you
can read more about this on the Firefox help page.)

How to Install and Use the Web Clipper for Google
Chrome

Before you can clip content to Evernote in Google Chrome, you'll need to install the Evernote
Web Clipper add-on for Google Chrome. Once you've installed the add-on, you'll have an
Evernote button at the top of your browser.

We've redesigned the clipper window to be smaller and more intuitive. In addition to the
streamlined look and feel, the newly-designed Evernote Clipper for Google Chrome will give
you several options for which content you'd like to clip:

Clip article - The clipper will figure out which part of the page is the content "of interest"
(using the Readibility engine from Arc 90) and automatically select that content to be
clipped.
Clip full page - Clips the entire web page

https://addons.mozilla.org/en-US/firefox/addon/evernote-web-clipper/
http://support.mozilla.com/en-US/kb/Enabling%20and%20disabling%20cookies
https://chrome.google.com/extensions/detail/pioclpoplcdbaefihamjohnefbikjilc
https://chrome.google.com/extensions/detail/pioclpoplcdbaefihamjohnefbikjilc


Clip URL - Clips only the URL of the current web page.
Clip selection - Clips the selected content (this option is only visible when a portion of the
web page has been selected).

And, of course, you still have the ability to manipulate the title, tag and ancillary text for
your clipped content before it's added to Evernote.

The Evernote extension for Chrome also allows you to browse or search your notes from
within the Evernote pop-up window. It also allows you to see all the notes you have created
on the current Web site using Evernote's Site Memory feature (read more about this on the
Evernote blog):

Here's a short video overview of the new Clipper for Google Chrome:

An Introduction to Sharing

Evernote now provides many different ways to share your notes and notebooks. Historically,
Evernote has allowed users to share notebooks with other users (as well as with the public),
but we've added several new capabilities to our desktop and Web applications that allow you
to share individual notes as well as whole notebooks. Let's take a look at the different
sharing options.

SHARING  INDIVIDUAL NOTES

Twitter and Facebook
Sharing your notes on Twitter and Facebook is now incredibly simple. Click "Share" in your
Windows or Mac application to easily publish the selected note to either of these popular
social networks. Evernote.com currently supports sharing with Facebook and Twitter support
is planned for a future release.

Email
This feature is part of the old guard and isn't exactly new, but it's a commonly used method
for sharing notes with other people, particularly people who don't use Evernote. This option
is also available in our new "Share" menu within the desktop clients and on evernote.com

By URL
Our most versatile offering in terms of sharing, this method allows you to share any note
virtually anywhere using a unique URL generated by Evernote. Selecting "Copy Note URL to
Clipboard" from the "Share" menu in Evernote for Windows or Mac or choosing "Link" when
viewing everote.com will give you a URL you can paste anywhere you like to share with just
about anybody.

SHARING  NOTEBOOKS

http://blog.evernote.com/2010/06/28/evernote-chrome-extension-gets-site-memory/
http://blog.evernote.com/2010/06/28/evernote-chrome-extension-gets-site-memory/


Both Evernote for Windows and Mac support sharing notebooks as well as reading and
tracking notebooks that have been shared with you. Let's explore the types of sharing in a bit
more detail.

Shared Notebooks
Evernote allows both free and premium users to share notebooks privately with other
Evernote users. Notebooks shared by premium users have the option of being editable by the
users with whom the notebook is shared. In other words, if Bob the premium user shares a
notebook with Fred the free user, Bob may choose to allow Fred to edit the contents of his
shared notebook.

Public Notebooks
Public notebooks (which are, essentially, shared notebooks) are visible to anybody who
knows the notebook's URL. Public notebooks can then be linked to other users' accounts so
their local copy of the notebook is updated whenever the notebook's owner adds or changes
the contents.

Sharing Your Notes and Notebooks with Evernote on the
Desktop

SHARING  NOTES

To share a note in Evernote, select a note and click "Share" at the top of the main Evernote
window:

Choose the medium by which you'd like to share your note. If you choose Twitter or
Facebook, Evernote will activate your browser and prefill the appropriate text field with your
note's title and URL (both of which you can edit before sharing).

If you choose Email, you'll be prompted to enter one or more email addresses with which to
share the note. You can also add additional text before sending the note via email.

Select Copy URL to Clipboard and Evernote will generate a unique URL for that note and copy
it to the system clipboard (so it's ready to be pasted into whichever application you'd like):

Note that once you share a note using any of the methods described above (with the
exception of email), that note is now "shared" - anybody who knows the URL can view the
note. In other words, sharing a note on Twitter does not share the note with only Twitter,
but with anybody who visits the link, no matter where they found it.

If you'd like to stop sharing a note, select the shared and click Edit > Sharing > Note Settings.
This will launch the sharing details dialog and, if you'd like, give you the option to stop
sharing the note.



SHARING  NOTEBOOKS

To share a notebook, right click the notebook name and choose "Share Notebook". This will
bring you to the Shared Notebook Settings pane where you can choose to share the notebook
with the world or with specific people.

Clicking "Share with the world" will prompt you to choose a name for the notebook (which
defaults to the current notebook name) and an option description, as well options for how
you'd like the notes sorted when the notebook is viewed. Click "Submit" to begin sharing
this notebook and get the URL for the notebook.

Clicking "Invite individuals to access this notebook" will give you a few fields to complete
including the email addresses of the people you want to share with, what type of
permissions these people will have and whether the user needs to login to Evernote before
viewing the notebook. You can also add an optional message that is sent to each recipient.

STOP  SHARING

To stop sharing a notebook, right-click the notebook name and choose "Share Notebook..."
once again. The Shared Notebook Settings screen will give you links to stop sharing the
notebook.

An Introduction to Saved Searches

As the amount of information you save in Evernote grows, so does the utility of Evernote's
powerful search capabilities. Similarly, you might find yourself frequently running the same
search over and over - saved searches are for you.

Let's say that you're routinely searching for the previous week's notes that contain images
and were created using your iPhone. This search would give you the results you want:
source:mobile.* resource:image/* created:week-1.

(read more about search operators here)

http://www.evernote.com/about/developer/api/evernote-api.htm#_Toc291595523


Typing this frequently can be a bit cumbersome, but you can save time and finger strain by
creating a saved search. Once you save the search and give it a name, you'll be able to run
the search by clicking the name in your Evernote client instead of typing a long search query
each time you want to see those notes.

Saved searches are synchronized to Evernote on the Web and, therefore, available on all of
your Evernote-enabled devices, including mobile devices.

Creating Saved Searches in Evernote for Mac

To create a saved search in Evernote for Mac, follow these steps:

After you've typed your query into the search field, click New Saved Search under the File
Menu:

This will launch a dialog box prompting you to name your search. Give the search a name
then click OK and your search will be saved.

Saved searches are available on the left-hand side of the main Evernote window under the
Saved Searches heading.



Importing Evernote Archives in Evernote for Mac

Note: This article describes how to import Evernote archive (.enex) files.

As advertised, any .enex file you create can be reimported into any Evernote desktop client.
To import an .enex archive in Evernote for Mac, follow these steps:

1. Choose "Import Notes from Archive" from the "File" menu.
2. Browse to the location of the .enex file you'd like to import.

You can also choose to import the tags included in your archive file by selecting or
deselecting "Import tags".

The import process will begin and the notes will initially be placed into a temporary
notebook. A dialog box will appear and inform you of this and give you the chance to add the
notes to a synchronized notebook.

Exporting Notes and Notebooks in Evernote for Mac

Evernote for Mac provides a simple way to export your notes. The exported note content can
be represented in HTML, which can be viewed in any web browser, or XML, which would be
useful for migrating data stored in Evernote to a different platform/service.

To export one or more notes, follow these steps:

1. Select one or more notes.
2. Click "File" then "Export Notes to Archive".
3. Choose the file name, taret directory and which format you'd like for your archive: .enex

(XML) or .html.

To export an entire notebook, follow these steps:

1. Right click any notebook, choose "Export Notes from [Notebook Name]..."
2. Choose the file name, taret directory and which format you'd like for your archive: .enex

(XML) or .html.

If you plan on importing this archive back into Evernote at some point, choose .enex as the
export format: this format will preserve the contents and format of your note(s) exactly and
they'll look the same when imported. If you want a "human-readable" version of your note(s)
or would like to publish them to the web, choose the .html export format.

Backing up and Restoring Evernote Data under OS X

BACKING UP YOUR  DATA

All of the data kept in Evernote (except data stored in a local, non-synchronized notebook)
synchronized with Evernote's servers on the web. This means that there are always at least
two copies of your information: your Mac and Evernote. If you decide that you'd like to
backup your own data, there are a couple of ways to do it under OS X:

1. You can periodically export all of your notes into an Evernote Archive (.enex) file and
store that someplace secure.

2. Using some type of backup software like Apple's Time Machine.



Creating an Evernote Archive of all of your notes is as easy as right-clicking "All Notebooks"
and choosing "Export All Notes". This will prompt you for the directory where you'd like to
keep the resulting .enex file. Note that this will, in effect, compile all of your notes (including
images, attached files, etc.) into one big file, so the backup may take a few minutes to
complete and the .enex file you end up with might be really large if you have lots of notes in
Evernote.

If you choose the latter method, the data that must be backed up lives in the /Users/[your
username]/Library/Application Support/Evernote/data directory, so you'll want to make sure
it's included in your backups. Most "set it and forget it" backup applications will back up your
home directory by default, but confirming that the Evernote data directory is included would
be a prudent move.

RESTORING  YOUR  DATA

To restore your Evernote data from a local backup made using Time Machine or some other
backup application, follow these steps:

1. Quit Evernote by right-clicking the elephant in the menubar and selecting "Quit".
2. Take the /Users/[your username]/Library/Application Support/Evernote/data directory

from your backup and overwrite the existing directory by pasting the backup in the
/Users/[your username]/Library/Application Support/Evernote directory.

3. Bring down your Mac's Internet connection by opening System Preferences, selecting the
Network pane and disabling any active network interfaces (Airport, Ethernet or FireWire).
Once all of these options have the red dot next to them, they've been disabled and you're
safe to continue. We're doing this to temporarily prevent Evernote from syncing while we
restore your recovered notes.

4. Right-click "All Notebooks" and export all notes to an .enex file, noting the location where
this file is saved.

At this point, regardless of which backup method you chose to use, you should have a .enex
file containing all of your Evernote data (either as genereted by the above recover steps or
from periodically exporting your notes). Follow these steps to restore the .enex file and
recover the lost notes.

1. Click "File", then "Import Notes from Archive". Select the .enex file you'd like to import. If
you'd like to include any tags applied to the exported notes when importing, make sure to
check the "Import tags" box at the bottom of the file chooser dialog.

2. Evernote will then import the archive into a new notebook called "[Archive Name]
Import". For example, if your archive file was named Stuff.enex, the destination notebook
will be named Stuff Import.

3. After the import process completes, it will tell you how big the import was (in terms of
bytes) and how much of your monthly upload quota remains, then ask if you'd like to
make the new notebook a synchronized notebook. Click "No".

4. Drag any notes you'd like to recover into whichever notebooks you'd them to live.
5. Once you've moved all of the notes you want to keep out of the import notebook, you can

delete the import notebook.
6. Go back to System Preferences and re-enable your Mac's Internet connection.
7. Click the "Sync" button in Evernote to sync your recovered notes.

This process it a little complex, as you can see. If you ever get stuck, you should defintely get
our support team involved.

http://evernote.com/about/support


Using Evernote's advanced search operators

Evernote search is powerful. It may look like a simple text search field, but the advanced
search syntax gives you the ability to search your notes by the date they were created, what
type of media (audio, images, etc.) they contain — even where they were created. Here is a
list of the most common search operators available, complete with examples.

OPERATOR DESCRIPTION EXAMPLE

intitle: Searches within the
title of the note.

intitle:coffee searches for notes whose title contains
"coffee".

notebook: Searches for notes
stored in the
specified notebook.

notebook:Finance will only search for notes within the
Finance notebook.

any: Will return notes
that match any of
the search terms.
Without this
operator, Evernote
search will return
only those notes
that match all of the
given search terms.

any: pizza beer will return all notes containing either
"pizza" or "beer" (removing any: would return only notes
containg "pizza" and "beer").

tag: Searches for notes
tagged with the
specified tag.

tag:medical will return notes that have the tag "medical".

-tag: Searches for notes
not tagged with the
specified tag.

-tag:medical will return notes that do not have the tag
"medical".

created:[datetime] Searches for notes
created on or after
the date provided.
Note that the date
provided must be
formatted like this:
YYYYMMDD or as a
date relative to the
current date (e.g.,
day-1 to represent
yesterday, week-2
to represent two
weeks ago, etc.)

created:day-2 will return notes that were created in the
last two days.
created:20101101 will return notes created on November
1, 2010.

updated:[datetime] This operator
behaves exactly the
same way as the
created: operator
described above,
except it deals with
the date a note was
most recently
modified. If a note
hasn't been
modified since it
was created, this
date will be the
same as the created
date.

updated:day-2 will return notes that have been updated
in the last two days.

resource: Allows you to search
for notes that
contain specific
types of media
(audio, images, etc.).

resource:image/jpg will return all notes containing an
embedded JPG image.
resource:audio/* will return all notes that cotain some
type of audio file.

latitude:, longitude:
and altitude:

Find notes that were
created at or near

latitude:37 will return all notes whose latitude value is
greater than 37. Add -latitude:38 to your search to show



the provided
coordinate.

results whose latitude is between 37 and 38 degrees.
longitude: and altitude: work exactly the same way.

source: Search notes by the
application or other
source used to
create them (e.g.,
mail.smtp for notes
added via email,
web.clip for notes
added using a web
clipper, etc.).

source:mobile.* will return all notes created on a mobile
application of some type. For a full list of possible values
for this search, see the Evernote Search Grammar
specification.

recoType: Matches notes that
contain some type
of recognition
information (such as
an image containing
text). Possible
values for this
operator: 'printed',
'speech',
'handwritten',
'picture' and
'unknown'.

recoType:picture will return all notes containing an
image whose contents have been processed by
Evernote's image recognition system.

todo: Finds notes
containing one or
more checkboxes.

todo:true will return all notes containing a checkbox that
is checked. todo:false will find notes containing a
checkbox that is not checked. todo:* will return notes
containing a checkbox, regardless of whether or not it is
checked.

encryption: Returns notes that
have been partially
encrypted using
Evernote's built-in
encryption system.

encryption: (this operator doesn't require additional
values).

For more information on the full library of Evernote search operators, head over to the
Evernote Search Grammar specification.

Overview of Encryption in Evernote

Evernote supports the encryption of text within notes. To encrypt a portion of a note:

1. Highlight the text you'd like to encrypt
2. Right-click the selected text and choose "Encrypt Selected Text"
3. You'll be prompted to enter an encryption passphrase. This passphrase will be required if

you'd like to decrypt this text later.
4. After entering the passphrase, click OK and your text will be encrypted. The encrypted

region will now look something like this:

http://www.evernote.com/about/developer/api/evernote-api.htm#_Toc277181469
http://www.evernote.com/about/developer/api/evernote-api.htm#_Toc277181469
http://www.evernote.com/about/developer/api/evernote-api.htm#_Toc277181469


Note: Once you've encrypted content within Evernote, it can only be decrypted using the
passphrase you chose. This means that nobody (including Evernote staff) can recover this
text if the passphrase is lost or forgotten.

It's also worth mentioning that Evernote doesn't support the encryption of any of the
following:

Images/PDFs
File Attachments (like Office documents)
Audio Clips
Whole Notes/Notebooks

Accessing and Using the Activity Log in Evernote for
Mac

The Activity Log is a running log of all of the various low-level actions that the Evernote
desktop application is performing. This log can be useful in diagnosing problems with the
Evernote application or service.

You can access the Activity Log by selecting the "Activity Log..." option under the Help menu
in Evernote for Mac. Once you've opened it, you'll see a long list of the various events that
happen behind the scenes in Evernote, as well as when they occurred. You can copy the
entire log to the system clipboard by clicking "Copy to Clipboard" or save the log as a text file
by clicking "Save As...".

If you want to filter the log by the different types of events being logged, click the "Advanced
Filters" button and deselect the items you do not want to see. For example, if you're having a
problem with Evernote sync, you can deselect the "Thumbnail Generator" and "Note
Processing" logging options, leaving only events related labeled "Synchronization".

Most users won't need to look at the Activity Log unless instructed to do so by our Support
department.

What are the keyboard shortcuts in Evernote for OS X?

Evernote can be driven almost entirely using only the keyboard. Below is a comprehensive
list of all keyboard shortcuts available for Evernote on Mac OS X.

Global

You can use those system-wide shortcuts while working in any application (provided
Evernote is running). You can redefine these shortcuts in the Preferences > Shortcuts tab.

SHORTCUT ALTERNATIVE ACTION

⌘ N New Note

⌘ ⇧ N New Notebook

⌃ ⌘ N New Tag

⌥ ⌘ N New Evernote Window

⌘ W Close

⌘ S Save

⌘ Y Quick Look Attachments



⇧ ⌘ P Page Setup

⌘ P Print

⌘ Z Undo

⇧ ⌘ Z Redo

⌘ X Cut

⌘ C Copy

⌘ V Paste

⇧ ⌘ V Paste Without Formatting

⌘ A Select All

⇧ ⌘ M Merge Notes

⇧ ⌘ X Encrypt Selected Text

⌥ ⌘ F Search Notes

⌥ ⌘ S Save Search

⌘ R Reset Search

⌘ F Find in Note

⌘ G Find Next

⇧ ⌘ G Find Previous

⌘ J Jump to Section

⌘ : Show Spelling and Grammar

⌘ j Check Spelling

⌥ ⌘ T Show Toolbar

⌘ 1 List View

⌘ 2 Mixed View

⌘ 3 Thumbnail View

⇧ ⌘ A Hide Unassigned Tags

⇧ ⌘ I Show/Hide Note Info

⌘ L Go to Selected Note

⌘ T Show Fonts

⇧ ⌘ C Show Colors

⇧ ⌘ T Insert To-do

⇧ ⌘ L Insert Table

⇧ ⌘ H Insert Horizontal Rule

⇧ ⌘ F Simplify Formatting

⇧ ⌘ O Toggle Numbered List

⇧ ⌘ U Toggle Bulleted List

⇧ ⌘
Tab Increase List Level

⇧ Tab Decrease List Level

⌘ K Add

⇧ ⌘ K Remove

⌘ B Bold

⌘ I Italic

⌘ U Underline

⌘ Bigger

⌘ - Smaller

⌘ { Align Left

⌘ } Align Right

⌘ | Center

⌘ M Minimize

⌘ 0 Activity



For more information on Evernote for Mac, consult our official Knowledge Base.
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